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Abstract: Every building has got its form, function and aesthetics. We consider that the 
Architects will take of them and the structural engineer will be responsible for strength and 
safety of structure. A building or structure should be constructed according to Indian 
Standard specified by the concerned department. Generally, there are different types of 
buildings such as Residential, Commercial centers, Offices and Educational and Institutional 
buildings, Government offices, etc.. STAAD.Pro allows structural engineers to analyses and 
design virtually any type of structure through its flexible modelling environment, advanced 
features and fluent data collaboration.  In this project we have designed a Primary health 
center building (RCC) using STAAD.Pro V8i which includes design of constituent elements 
such as slabs, beams, columns and footings. Study of loads acting on building and R.C.C 
design with reference to IS875 and IS456-2000. We conclude that Staad pro is a very 
powerful tool which can save much time and is very accurate in Designs. Primary Health 
Centre (PHCs), sometimes referred to as public health centers, are state-owned rural health 
care facilities in India. They are essentially single-physician clinics usually with facilities for 
minor surgeries, too. They are part of the government-funded public health system in 
India and are the most basic units of this system. Presently there are 25,308 PHCs in India. 
Thus, it is concluded that Staad pro package is suitable for the design of a multistoried 
building 
KEYWORDS: IS Codes, Staad Pro V8i 
 

INTRODUCTION 
 

A civil engineer is responsible for planning and designing a project, constructing the project 
to the required scale, and maintenance of the product. A civil engineer requires not only a 
high standard of engineering knowledge but also supervisory and administrative skills. The 
planning part of their work involves site investigation, feasibility studies, creating solutions to 
complications that may occur and the actual designing of structures. They have to work with 
the guidelines of the local government authority and get plans approved by the relevant 
authority. They may prepare cost estimates and set construction schedules. Construction work 
involves dealing with clients, architects, government officials, contactors and the supervision 
of work according to standards. Their work also involves the maintenance and repair of the 
project. 
The major specializations within civil engineering are structural, water resources, 
environmental, construction, transportation, geo-technical engineering etc. On most projects, 
civil engineers work in teams or in coordination with many other engineers. They can find 
work as a supervisor of a construction site or a managerial position or in design, research as 
well as teaching in government services or private concerns. They can also work as 
independent consultants. 
National Building Code (NBC- Indian standard codes) is a document containing standardized 
requirement for the design & construction of most of types of building in the Country. 
Although codes may sometimes seem fussy, they are the result of years of experience and 
testing. Building codes exist to protect the public's health, Safety and welfare, National 
Building Code (NBC) regulates building construction & building use in order to protect the 
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health, safety & welfare of the occupant. One should always take the correct precautionary 
measures to assure the safety of Occupants. 
 

LITERATURE REVIEW 
 

A Study on Market Orientation and Service Quality in Primary Hospital in Telangana State”  
Sampling Methods  
Two stage sampling method is used, first Quata Sampling and then Convenience sampling. 
As sample unit in health care do not constitute a homogeneous group so for better analysis 
different geographical region are selected in Telangana state, quota sampling is used. The 
sample items are selected using Convenience sampling. To obtain better representation of the 
population, samples are consisting of respondents from different age group, gender, income 
range, employment, marital status and education level.  
This study is limited to the Telangana state only. Keeping in view professional ethics and 
integrity names of the hospitals have been kept in abeyance.  
Sources of data  
Secondary Data: For conceptual clarity information that is obtained from previously 
published materials such as books, magazines, journals, health care publications and 
websites.  
Primary data: Information will be gathered using Structured Questionnaires as the survey 
instrument.  
Research objectives  
The increasing perception of quality of services in healthcare customers’ systematic demands 
and hospital core performance leads to an increasing concern for understanding 
patient/consumers and patient/consumer families’ needs in a hospital environment. In fact, 
given the humanitarian nature of health services, patient/consumer satisfaction in healthcare 
is not only important for the sustained profitability or survival of the hospital, but also for 
increased effectiveness and efficiency, and for better treatment outcomes. Healthcare 
organizations, specifically hospitals, are continuously trying to improve on their image and 
their services.  
The present study explores the relationships among market orientation and quality of services 
in multi-specialty hospitals.  

 To study market orientation practices of selected multi-specialty hospitals in 
Telangana state.  

 To study service quality dimensions of selected multi-specialty hospitals in Telangana 
State.  

 To study the impact of market orientation practices on service quality dimensions of 
multi-specialty hospitals in Telangana state.  

 To assess how demographic and other factors are affecting on perceptions of quality 
of services in multi-specialty hospitals in Telangana State.  

SPECIALITIES OF HOSPITAL  
At one-fourth the cost for the normal people and free for poor people.  
Cancer, surgery, bone marrow, transplant, angioplasty, micro neurosurgery, Parkinson, 
paralysis, diabetes, HIV/AID, Tuberculosis, Gaynor, Child health etc.  
Apart from India, Nepal, Bangladesh, Srilanka, Mauritius. Also Africa, Middle East, U.K., 
Europe & USA.  
Apart from the state-an-art traditional/specialized medical facilities, Hospital will have Indian 
Heritage medical/medicine facilities such as Ayurvedic, homeopathic, Unani, Yoga, 
Meditation Holistic, Herbal, Stem cell etc.  
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Hospital will have the arrangement for all the indoor patient MEDICLAIM facilities with the 
association of various Govt. & other agencies for best treatment.  
Initially charitable facilities will be available to the 20% of people against the full capacity of 
the hospital and then slowly-slowly these facilities will be extended up to 50% within period 
of 7 years after developing the corpus funds of Rs. 300 Crore.  

STRUCTURAL ANALYSISING AND DESIGN (STAAD PRO) 
Structural Design Using STAAD- PRO  
“Concurrent Engineering” based user environment for model development, analysis, design, 
visualization and verification.  
Full range of analysis including static, P-delta, pushover, response spectrum, time history, 
cable (linear and non-linear), buckling and steel, concrete and timber design.  
Comparison  
 Limitations of Hand Computation Methods  

 Applicable for small problems  
 Tedious for even medium sized problems  
 3-d analysis almost impossible  

Advantage for Invention of Computer  
 Matrix methods of structural analysis  
 Development of numerical techniques  
 Finite element method  

STAGES IN STRUCTURAL DESIGN: 
The process of structural design involves the following stages. 

1. Structural planning. 
2. Action of forces and computation of loads. 
3. Methods of analysis. 
4. Member design. 
5. Detailing, Drawing and Preparation of schedules. 

 

 
Fig. Showing the typical column layout G+2 RC Framed Building 

 
Column – 230 x 380 mm 
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Fig. Showing the First Floor/Second Floor Beam Layout of G+2 RC Framed Building 

 
 Beam – 300 x 450 mm 
 
 
 
 
 
 

 
Fig. Showing the 3D View of G+2 Building 

 
Dead load: 
Dead loads are permanent or stationary loads which are transferred to structure throughout 
the life span. Dead load is primarily due to self-weight of structural members, permanent 
partition walls, fixed permanent equipment’s and weight of different materials. 
Load calculations 
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Self - weight of Slab load: 
Floor loads for 150mm thick slab 
Thickness of slab -150mm 
Unit weight of reinforced concrete - 25.00kn/m3 
= 0.15 x 1x 25 
= 3.75 KN/m2      
Dead load of slab= 3.75kn/m2 
Floor finishes     = 1.50kn/ m2 
         = 3.75 x 1. 5 = 5.25 Kn/m2 
Total load of slab =   5.25kn/ m2 
Self-weight of Beam Load: 
Beam Size- 300x450mm 
Unit weight of reinforced concrete - 25.00kn/m3 
   = 0.3 x 0.45 x 25 
  = 3.375Kn/m3 
Wall loads 
External Wall 
230mm thick wall for 3.5 heights 
Thickness of wall ‘b’ - 0.23m 
Height of walls ‘h’ - 3.5mm 
Unit weight of brick masonry γ - 19.2kN/m3 
     = 0.23 x 3.5 x 19.2  
Total load h*b* γ   = -15.456 kN/m3 
Internal or Partition Walls 
150mm thick wall for height 3.5m  
Thickness of wall ‘b’ - 0.15m 
Height of walls ‘h’ - 3.5m 
Unit weight of brick masonry ‘γ’ - 19.2kN/m3 
= 0.15 x 3.5 x 19.2 
Total load h*b* γ = -10.08 kN/m3 
Parapet & Balcony wall load 
Thickness of wall ‘b’  - 0.115m 
Parapet wall ‘h’ - 1.00m 
Unit weight of brick masonry ‘γ’ - 19.20kn/m3 
    = 0.115 x 1 x 19.2 
Total load    h*b* γ  = 2.208 kn/m3 
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Fig. Showing the Dead load Application G+3 Building 

Imposed loads or live loads: 
Impact loads: 
Impact load is caused by vibration or impact or acceleration. Thus, impact load is equal to 
imposed load incremented by some percentage called impact factor or impact allowance 
depending upon the intensity of impact. 
 
Live load as per Code IS: 875 (Part-2) 
Patient rooms  - 4.000kn/ m2 
Stair case, corridor - 3.000kn/ m2 
Terrace, portico - 2.000kn/ m2 
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Fig. Showing the live load Application G+2 Building 

 
Wind loads: 
Wind load is primarily horizontal load caused by the movement of air relative to earth. Wind 
load is required to be considered in design especially when the heath of the building exceeds 
two times the dimensions transverse to the exposed wind surface. For low rise building say 
up to four to five story’s, the wind load is not critical because the moment of resistance 
provided by the continuity of floor system to column connection and walls provided between 
columns are sufficient to accommodate the effect of these forces. Further in limit state 
method the factor for design load is reduced to 1.2 (DL+LL+WL) when wind is considered as 
against the factor of 1.5(DL+LL) when wind is not considered. IS 1893 (part 3) code book is 
to be used for design purpose. 
Design Wind Speed Vz = Vb x K1 x K2 x K3 
Where 
Vb- Design Wind speed 
K1- Probability factor 
K2 – Terrain factor 
K3- Topography Factor 
Exposure factor is -1.0 (As per code) 



International Journal of Multidisciplinary Engineering in Current Research - IJMEC 

 Volume 9, Issue 6, June-2024, http://ijmec.com/, ISSN: 2456-4265 

 
 

ISSN: 2456-4265 

IJMEC  2024 
35 

 

 
Fig. Showing the wind load Application on G+2 Building 

 
ANAYLSIS RESULTS 
Load combination:  
The structure has been analyzed for load combinations considering all the previous loads in 
proper ratio. In the first case a combination of self-weight, dead load and live load 
(1.5(DL+LL)) was taken in to consideration. In the second combination case instead of wind 
load seismic load was taken into consideration.   
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Fig:  Bending forces at Direction –Z & Y 
 
Analysis Methodology  
Elastic analysis method is used to obtain the forces and moments for design. Analysis is done 
for the primary and combination loading conditions provided by the user. The user is allowed 
complete flexibility in providing loading specifications and using appropriate load factors to 
create necessary loading situations. Depending upon the analysis requirements, regular 
stiffness analysis or P-Delta analysis may be specified. Dynamic analysis may also be 
performed and the results combined with static analysis results. 
 
 
Performing Analysis/Design 
STAAD.Pro performs Analysis and Design simultaneously. In order to perform Analysis and 
Design, select the Run Analysis option from the Analyze menu.  

 
Fig: Run Analysis 

If the structure has not been saved after the last change was made, you should save the 
structure first by using the Save command from the File menu. 
When you select the Run Analysis option from the Analyze menu, the following dialog box 
appears: 
Click on the Run Analysis button. 
As the analysis progresses, several messages appear on the screen as shown in the figure 
below.  

 
Frame A  
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Bending Moment Frame A 

 

 
Shear Force Frame A 
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Axial force of a Frame A 

 

 
Deflection of Frame A 
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Bending Moment of Whole Structure 

 
Shear Force of Whole Structure 
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Axial Force of Whole Structure 

 
Deflection of Whole Structure 

 
 
After doing all the structural analysis of our structure, we have designed it to find out the 
steel used for the reinforcement for the columns and beams. 
By selecting the code IS: 456 2000 for the concrete design we will then define parameters for 
our design as: 
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Fig: Torsional Force and Beam Stress on G+2 Primary Hospital Building 

 
 

CONCLUSION 
The empirical evidence examined in the research suggests that the notions of therapeutic or 
patient-friendly environments held by participants in the study were based upon three 
conceptual visions of the role and function of the built environments of health care facilities. 
They are: the notion of homeliness, the notion of physical and visual clarity and accessibility 
through the spaces, and the notion of supportive environments as discussed in the answers to 
the research questions below. The program contains a number of parameters which are 
designed as per IS: 456 (2000).  Beams are designed for flexure, shear and torsion.  
Columns are designed for axial forces and biaxial moments at the ends. All active load cases 
are tested to calculate reinforcement. The loading which yield maximum reinforcement is 
called the critical load.  
We can conclude that there is theoretical and practical work done. As the scope of 
understanding will be much more when practical design work is done. We design basic 
structural elements (slab, beam, columns and footings). As we get more knowledge in such a 
situation where we have great experience doing the practical work 
After obtaining STAAD Analysis and Design the results are seemed to be more accurate 
when compared to manual design results. During the project work many obstacles were faced 
to obtain error less STAAD output .The future work can be carried in continuation of this 
work. The main drawback of STAAD is Designing slabs is tedious job. 
 

FUTURE IMPLICATION 
 

This research is the first of its kind to study the building environment and human behavior in 
the context of Indian healthcare buildings and even so, for the aspect of therapeutic built 
environment in the cancer care built environment. The research on the therapeutic aspect in 
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the cancer care environment is a new conscious perspective in Indian hospital planning and is 
to be incorporated in all types of specialty hospital buildings. The research topic is a 
forerunner in identifying the significance and impact of the building on the human physical 
and physiological needs in Indian hospitals; the area of the study is complex and colossal and 
hence the research is restricted to Hyderabad with the focus on cancer care, while the 
intricacy and enormity of the issue is to be realized in future research. 

 The research was focused on the cancer care facilities in Telangana state therefore, the 
work is representative of the users’ therapeutic needs specific to the context. The 
future implications of the research are: 

 To consider the research as a developing pilot work for the study of further 
therapeutic needs for cancer care facilities at various context - from city to region, to 
state and to national level. 

 To serve as a design evaluation model, to provide insight into the degree of 
therapeutic need of the user degree in pre and post occupancy assessment. 

 To further extend the study to physically map and quantify the specific therapeutic 
architectural spaces required in the 

 Outpatient, Diagnostic and Inpatient areas of the cancer care facilities. Extension of 
the research further on the wider scale – regional and national level on the cancer 
specialty. 

 To test, evaluate and integrate the therapeutic design aspects and elements in the 
existing or new cancer specialties. 

 To decipher the wide diversity of citizens, and community views, including ethnic 
groups, socioeconomic, culturally relevant outlook as cancer healthcare design 
variables. 

 Extension of the therapeutic need enquiry to other clinical specialties based on the 
illness or on the user types (children, older people, etc). 

 Future research is required to study the therapeutic needs in healthcare facilities at the 
primary and secondary care level of the Indian healthcare system. 

 Future enquiry into the therapeutic needs to be made multidisciplinary by including 
disciplines like management, medicine, art, product design etc 

 Increase the level of enquiry and expand the area of study to dovetail future Medicare 
developments and subsequent changes in the socio-physical demand of the user. 

 Future research should include health impact analysis of the built health care 
environment upon the health status of the local community. 

The research concludes that the need for satisfaction is largely determined by three factors, 
namely, the strength of the needs and intensity of gratification, the socialized behavior 
patterns in conjunction with the person’s previous experience of need gratification, and the 
perceived importance of the need. In reality, each person responds to a need as an organized 
whole and each processes is interconnected with the others. 
In summary, the research has explicitly highlighted the users’ preference and experience in a 
cancer care environment. However, the ecology of healthcare is necessarily a changing 
subject for research and evaluation, and improving the patient’s experience will continue to 
be an issue for those involved directly and indirectly in healthcare. What is clear is that many 
of the principles that were adopted in planning this new environment, including those 
associated with the planning and consultation process, the integration of humane value, and 
the recognition of the fundamental and changing needs of the user groups, will continue to 
inform future developments in this and other care environments. 
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